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Introduction

Color has the ability to communicate, to please, to excite, and to engage. Color makes 
a difference—often a dramatic difference—in your photographs, your graphics, and 
your layouts. Getting color right early in the workflow, and keeping it right to the end, 
is increasingly critical in the fast-paced, deadline-driven digital world. Yet photographers 
and designers are frequently dismayed when they print an image and the color is wildly 
different from expectations. These disruptive surprises can cost time and money and 
cause delivery delays and disappointed clients.

Color is an elusive phenomenon. Say “red,” and you’re describing a sensation that your 
eyes and brain associate with a certain wavelength of light. But exactly how “red” is 
the red? Computers use numbers to more precisely define color; for example, Red 255, 
Green 0, Blue 0 is a ratio of numbers that describes the maximum “red” in a digital file. 
But what does this red really look like? And how do you ensure its consistency at every 
step of the workflow—from capture to computer screen to ink on paper—when each 
camera, scanner, and printer records or outputs colors a bit differently?

Mac OS X version 10.4 Tiger provides a robust, standards-based solution for color man-
agement. ColorSync, Apple’s universal color translator, delivers consistent and accurate 
color across devices and at all stages of production. With ColorSync integrated into 
Mac OS X, you can implement a complete color-managed workflow.

ColorSync extends the capabilities of creative professionals by making the management 
of color effective, predictable, and practical. Participants in the creative and production 
processes will experience these benefits:

• Accurate color that matches expectations

• Consistent color over time, across media, and using multiple vendors

• Better coordination among distributed team members

• Reduced production timetables, based on shorter and fewer review cycles

• Reduced costs from greater efficiencies, fewer paper proofs, and less rework

• More satisfied clients, based on faster turnaround, lower costs, and higher-quality 
products

ColorSync and Mac OS X deliver on the promise of higher productivity through the 
accurate representation and consistent reproduction of color. The color you capture 
is consistent from the screen to the finished printed product. No waste. No surprises. 
No disappointments.

This Technology Tour provides step-by-step examples that show you how to put the 
advanced color management capabilities of Mac OS X Tiger into practice in your day-
to-day work. 
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 The ColorSync Foundation

Creative workflows make use of a wide variety of imaging devices, such as digital 
cameras, scanners, printers, and computer displays. But for each device, the same com-
bination of numerical values yields a different color. For example, a single pixel where 
red equals 100, green equals 100, and blue equals 100 should produce a completely 
neutral gray tone, but on some devices the gray will look warm, or reddish, and on 
others the gray will look cool, or bluish. The inherent disparities between the devices 
can cause the colors within an image to render differently from one device to another.

In fact, every device—from scanners to displays to printers—has unique color capa-
bilities. Successful color management involves translating color accurately from one 
device to another across your workflow.

The International Color Consortium (ICC) was established to address this issue. 
Founded in 1993 by Apple and seven other vendors, the ICC now has a member base 
of more than 70 industry-leading manufacturers and software developers, including 
Sony, Hewlett-Packard, Creo, Adobe, and Quark. The charter of the ICC is to create and 
promote an open color management architecture and vendor-neutral file formats. At 
the core of its development efforts are ways of characterizing device color and trans-
forming colors between devices.

ColorSync is Apple’s implementation of the ICC specification, providing system-level 
color management of images, documents, and devices. ColorSync is fully integrated 
into Mac OS X, ensuring that powerful color management tools can be accessed from 
every application for consistent color. In fact, Mac OS X is the only operating system 
that fully supports the ICC version 4 standard for managing color—delivering the 
industry’s most advanced OS-level color management system.

In its simplest form, an ICC-based color management system includes three basic 
components: the ICC color profile describes the color characteristics of each device, the 
color management module does the color conversion, and the rendering intent defines 
the way in which the conversions are performed. The following sections examine 
these basic components and their roles in the workflow.
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ICC Color Profile
Good color management starts with a color profile, a cross-platform file that describes 
a particular device’s color characteristics. When a printer, scanner, or digital camera 
is connected to your system, ColorSync automatically assigns an ICC profile to that 
device. In most cases, this is a profile that the device’s manufacturer has supplied—a 
factory profile.

While many devices come with ICC profiles that ColorSync can automatically assign, 
others will need you to specify the ICC profile. Some manufacturers provide ICC 
profiles on their websites, and service providers often supply ICC profiles particular 
to their devices. Professional users may want to create their own, as the accuracy of 
profiles custom-built for a specific device may be far superior.

The ICC color profile describes the total volume of colors for a device, or its color 
space. For example, an RGB value of R10, G100, B10 is a ratio of colors describing a 
green color—but how green? Profiles define the range of colors, or gamut, a device 
is capable of producing.

For color management to work correctly, two pieces of information are needed: the 
color characteristics of the source of your image (its input or source profile) and how 
the image will be reproduced (its output or destination profile). ColorSync uses the 
color profiles to match color from input to display to final output, adjusting for the 
color characteristics and any limitations of the devices in the workflow—a process 
called color conversion.

TM TM

Digital Camera

Drum Scanner

Four-Color Process

Commercial Press

The Web

Scanner
Display

Soft Proofing

The ColorSync Workflow

What is a color space?
A simple set of numbers, in either RGB or 
CMYK, does not provide enough information 
to define and reproduce exact color on 
different devices. For example, an RGB value 
of R10, G100, B10 does not define how that 
color should appear; it is just the ratio of the 
three RGB components.

By specifying a scale for these RGB values 
within the range of human vision, R10, G100, 
B10 can replicate how this green should 
appear. This scale is called a color space. 
The total volume of color in a color space 
is referred to as the color gamut.

R10, G100, B10 in two different color spaces 
such as sRGB and Adobe RGB (1998) will not 
produce the same color, even though they 
share the same ratio of RGB numbers. The 
greenest green in Adobe RGB (1998) is more 
saturated than the greenest green in sRGB 
because the scale of the two color spaces is 
different. The Adobe RGB (1998) color space 
has a larger color gamut than sRGB. 
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Color Management Module
To reproduce consistent color from camera to display to printer, a translation—known 
as a color space conversion—has to occur between devices. The color management 
module, or CMM, is the mathematical engine that ColorSync uses to perform the color 
transformation based on an ICC device profile to produce the expected color. The more 
accurate the ICC profiles are for each device, the greater the consistency that ColorSync 
will have in translating color from device to device.

When an image created with a digital camera is displayed, the CMM translates the color 
space of the camera (its input profile) to the color space of the display (the destination 
profile). Another such translation occurs when the image is printed, using the ICC profile 
to define the printer. For each translation, the CMM must consider the gamut of colors 
for each device and what must be done to accommodate the differences. This is where 
rendering intents come in.

Rendering Intent
Because color spaces can vary greatly, the rendering intent determines how the CMM 
will translate colors from one device’s color space to that of another. Each ICC profile is 
tagged with a default rendering intent (usually perceptual), but the user might prefer 
to select a rendering intent from within a color-savvy application. The following four 
rendering intents are used to reflect different imaging requirements.

Perceptual. The perceptual rendering intent preserves the relationship between colors 
by scaling the entire source space into the destination space, including those colors that 
were in the source gamut. Perceptual intent produces the most pleasing color results 
and is generally recommended for continuous-tone images and photographs, where 
reproducing exact hues is not necessary.

Saturation. With this intent, the relative saturation of colors from gamut to gamut is 
reproduced for the brightest, most vivid results. Saturation intent is designed primarily 
for business and vector-based graphics. 

Relative colorimetric. This intent changes only the colors that fall outside the gamut 
of the destination device. Colors are scaled relative to the destination profile’s white 
point; the whitest white of the source space is mapped to the whitest white of the 
destination space. The relative colorimetric intent often produces a more appealing 
result than the perceptual intent, because it preserves colors within gamut.

Absolute colorimetric. This rendering intent matches in-gamut colors exactly, repro-
ducing the white point of the source profile on the destination device, but clipping 
out-of-gamut colors to the nearest hue. Absolute colorimetric intent is best for rendering 
signature colors, such as Coca-Cola red or Eastman Kodak yellow, and is most useful for 
soft proofing.

With a basic understanding of the components of a color-managed workflow—the ICC 
color profile, the color management module, and the rendering intent—you can achieve 
predictable and consistent color. With this workflow, the color you capture will be the 
same color you see onscreen and in the finished printed product. No waste. No surprises. 
No disappointments.
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ColorSync Utility
Mac OS X comes with ColorSync Utility, which serves as the dashboard for your color 
management activities. This application is located in the /Applications/Utilities folder 
and gives users a single view into the components of a color-managed workflow. With 
ColorSync Utility, users can inspect, edit, and assign profiles to specific devices, includ-
ing printers, cameras, scanners, and displays.

As previously noted, every device connected to Mac OS X is automatically assigned 
at least one factory ICC profile in the ColorSync device registration database. In some 
cases, a single device—such as a printer—may have multiple profiles registered 
because paper type has a great impact on final color. The device registration database 
is available to all Mac OS X applications, enabling seamless device integration.

The following sections explore the tools in ColorSync Utility.

Profile First Aid
Mac OS X Tiger supports the latest implementation of the ICC color management 
specification; however, legacy profiles may need to be updated or repaired. Using 
Profile First Aid, ColorSync prevents outdated, corrupt, or poorly written profiles from 
bringing inconsistent color to your workflow. Profile First Aid verifies profiles on your 
hard drive and checks them for validity or corruption. 

If a profile doesn’t meet current specifications, if its data is invalid, or if a tag is written 
incorrectly, Profile First Aid diagnoses the problem and can repair it with the click of a 
button. Profile First Aid verifies only the format of the profile, not the accuracy of the 
color it describes.

Viewing and editing profiles
ColorSync Utility lets you view and edit ICC profiles and view specific details integral 
to managing professional workflows. Click the triangle in the top corner of the profile 
list to choose how the profiles are sorted—by location, class, or color space. Click the 
disclosure triangles in the profile list to show or hide profiles based on the current 
sorting.

You can also select a profile in the list to display its name, location, origin, creation 
date, and more. You’ll notice that every profile has an internal name that describes the 
device and its utilization, in addition to filenames determined by the operating system 
that created them. For example, the file might be named “pcdcnycc.pf,” but its internal 
descriptive name is more complete: “KODAK Photo CD Color Negative V3.0.” 

ColorSync Utility lets you inspect detailed information about each profile, including 
headers, tags, and color gamuts. You can even plot the gamut as a 3D shape—making 
it easy to compare the relative color spaces of different devices. Because color spaces 
are three-dimensional, you can drag the gamut map to rotate it. 

You can also compare the color gamut of two profiles using ColorSync Utility; for 
example, the gamut of your desktop printer compared with the gamut of a commer-
cial printer. Ideally, you want the printer that proofs color to have a gamut at least 
as large as that of the final output device, or you will not be able to print the full 
color gamut. 

ICC profile location
ColorSync profiles are stored in several 
locations in Mac OS X. The operating sys-
tem installs profiles in a read-only location: 
/System/Library/ColorSync/Profiles. Users 
should install profiles in the other locations 
to allow access control and editing of the 
profiles. 

• For all users of the same Mac system: 
/Library/ColorSync/Profiles

• For a specific individual user of the system:
~/Library/ColorSync/Profiles 

• For access over a managed network: 
/Network/Library/ColorSync/Profiles
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To compare two ICC profiles, click the first profile you wish to compare, then click the 
triangle next to the Lab Plot label and choose “Hold for comparison” from the pop-up 
menu. Next, from the list on the left, select any other ICC profile that you wish to com-
pare with the first profile. Both will be locked together; however, you can rotate the 
gamut view once you place the cursor in the gamut window area. To zoom in on the 
gamut, hold down the Option key and drag.

 

A visual comparison of the color gamut of Generic RGB and Generic CMYK in ColorSync Utility. 
CMYK is quite a bit smaller in volume compared with RGB. These examples illustrate significant 
differences between color spaces and the need for professional-level color management.
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Double-click a profile name in the list and a secondary window appears, showing 
detailed information about the profile. This window provides a way to view the data 
that makes up the definition of the color space and other information. While some 
of this data can be edited, doing so may result in inaccurate color transformations, 
unless you have a strong knowledge of the ICC color profile specification.

Detailed color profile information in ColorSync Utility.

For more information about profile tags and other ICC specifications, refer to 
www.color.org.

Registering profiles to devices
When a printer, scanner, or digital camera is connected to your Mac, ColorSync auto-
matically assigns the device an ICC profile—in most cases, the factory profile supplied 
by the manufacturer. The Devices pane in ColorSync Utility is where specific profiles 
can be created for each device.

Whether you are supplied an ICC profile or you create your own, you can change the 
profile registered for each device by selecting a device from the list on the left side of 
the Devices pane and clicking the Current Profile pop-up menu. When you select the 
ICC profile you wish to use, it becomes associated with the device. The name of the 
Current Profile is updated to reflect your change.
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Registering color profiles to devices in ColorSync Utility.

Some devices, like printers, may have many profiles assigned to them—usually to 
reflect the different characteristics of each paper or media used. A blue dot indicates 
the default profile to be used. In the case of printers, the correct ICC profile is selected 
based on the paper type chosen in the Print dialog.

Quartz Filters
Quartz is the PDF-based graphics system in Mac OS X that draws graphic elements on 
displays and output devices. Quartz Filters give users the ability to apply color manage-
ment, effects, and other processes when creating a PDF file or printing. You can create 
your own Quartz Filters using the controls in the Filters pane in ColorSync Utility. More 
information about Quartz Filters is included in the “Using Quartz Filters” section. 

Calculator
Using the Calculator tool in ColorSync Utility, you can compare the impact of color 
models, color spaces, rendering intents, and the translations that occur when color 
transformations are performed by the CMM. This tool provides a way to empirically 
see the impact that each element has in color transformations.

The Calculator tool in ColorSync Utility can compare color spaces.
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Color space conversions
ColorSync Utility can also be used as a tool for color space conversions on images. 
When you open an image in ColorSync Utility, you see the image along with additional 
options at the bottom of the screen. For example, to apply a sepia-tone profile to the 
image, choose Apply Profile from the left pop-up menu, Abstract from the middle pop-
up menu, then select Sepia Tone.

You can also convert an image for an output device by selecting the Output menu 
and the appropriate printer profile. When converting to an output color space, you 
can choose a rendering intent for the color space conversion using the Intent pop-up 
menu. Click Apply to see a soft proof of how the image will appear after conversion. 
Choose the rendering intent that produces your preferred color appearance based on 
the image and the profiles being used. Choose Save As from the File menu to apply the 
conversion and save the new file to your hard drive, ready for output to that particular 
output device.

 

Applying a color profile with ColorSync Utility.
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Color Workflow: Capture

Images and color-critical documents may come to you from a variety of sources. You 
might download images from cameras. Or scan the images. Or images and documents 
could come to you via email, FTP, the web, and CDs or other media. Ideally, images you 
receive from colleagues will already have a profile embedded that accurately describes 
the color within. If so, you can proceed to the next phase of the workflow. But what 
about images coming from devices such as digital cameras or scanners? What about 
images that do not have color profiles embedded? ColorSync and Mac OS X can assist 
you in the capture phase of your workflow.

Image Capture
Images need an ICC profile to define their color space. The Image Capture application 
lets you set your preferences for capturing and embedding these profiles in the images. 
The images captured are automatically color-managed. The Image Capture framework 
in Mac OS X allows other applications to download color-managed images as well.

Image Capture automatically recognizes devices such as scanners and digital cameras 
and completes a number of color management tasks. You can set Image Capture to 
assign and embed an ICC profile in each file as images are downloaded to your Mac. 
This application can save you hours of work by automatically applying the correct ICC 
profile to each input device.

As a framework built into Mac OS X, Image Capture provides a common method for 
downloading images from a camera and into an application. It is used by applications 
such as Aperture and iPhoto and by many third-party developers. With such a frame-
work in Mac OS X, users experience a familiar method for downloading images, and 
developers can spend more time creating compelling applications.
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Setting a color profile to a specific camera in Image Capture.

You can also assign ICC device profiles to your digital camera or scanner using 
ColorSync Utility, as previously described. This information is then recognized by 
Image Capture and used for all images from that device. It is easy to assign a different 
profile if you need to. Once you launch Image Capture, it detects the device you’ve 
connected to your Macintosh. Simply click Options and select any ICC profile you wish 
to assign to files from this device. 

Images without Profiles
Files without an embedded ICC profile are generally referred to as untagged images. 
Untagged images present a problem for any color management system because the 
color space is not defined, and therefore assumptions must be made regarding the 
color contained within. Since Mac OS X and color-aware applications such as Adobe 
Photoshop work best with tagged images, it is advisable to avoid untagged images. 

There are a number of ways to determine whether an image has an embedded profile 
in Mac OS X. You can select the image in the Finder and choose Get Info. Or you can 
open it using Preview and choose the Get Info command from the Tools menu—this 
will provide a wealth of information about the image, including the embedded ICC 
profile. Spotlight in Mac OS X Tiger can also be used to find information about 
documents, including the embedded profile and other EXIF (Exchangeable Image 
File) data commonly embedded in graphic file formats. 

Untagged images and Generic RGB
The integrated color management in 
Mac OS X requires that all images reference 
ICC profiles to describe color accurately 
from device to device. In situations where 
an image lacks a profile (it is untagged), 
Mac OS X assumes that the image was 
created with a special “generic” color space. 
Mac OS X includes Generic RGB, Generic 
CMYK, and Generic Gray profiles that repre-
sent approximate color space assignments 
for untagged images. While these profiles 
ensure consistent behavior when viewing 
untagged images, it is recommended that 
you tag your images with the correct profile 
when they are created. For more information 
on Generic RGB, see Technical Note QA1430 
at http://developer.apple.com/qa/qa2005/
qa1430.html.
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Assigning color profiles, and the Document Info pane in Preview.

To assign and embed a profile in a file opened in Preview, choose the Assign Profile 
command in the Tools menu and select the correct profile from the pop-up menu 
(see figure above). Once you click OK, the soft proof is modified based on the profile 
selected. While the numeric values in the image have undergone no change, the 
definition of those numbers has been supplied. Preview updates the soft proof based 
on this new color space.
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Color Workflow: Edit

Calibrating and Profiling Your Display
Once you have captured your images and embedded the appropriate ICC color profile, 
you are ready to begin editing them to suit your needs. However, because your display 
is the window into everything you do, first ensure that an accurate color profile is pro-
duced for your display. By calibrating your display and using a custom profile, you can 
trust the color you see on your display and be able to view and modify color in your 
images more accurately.

While Mac OS X has already assigned a factory profile to your display, conducting your 
own calibration of the display based on your environmental conditions is highly recom-
mended. Mac OS X provides the tools to do this using the Display Calibrator Assistant.

The Display Calibrator Assistant is accessed from the Displays pane of System 
Preferences. In the Color pane of the Displays preference pane are options for selecting 
the current ICC color profile for your display, as well as a Calibrate button, which opens 
the Display Calibrator Assistant.

The Display Calibrator Assistant in Mac OS X.

When calibrating your display using the Display Calibrator Assistant, be sure to select 
the Expert Mode checkbox, which will enable a finer set of adjustments to your display 
profile. The onscreen instructions walk you through the process of calibrating the dis-
play (see screen above). An ICC color profile will be generated and registered to your 
display for ColorSync to use. As a general practice, it’s best to calibrate your display 
once a month at its native resolution.

Calibration devices
For maximum accuracy in calibrating and 
profiling a display or output device, a 
hardware calibration device such as a color-
imeter or a spectrophotometer can be used. 
Colorimeters are most often used for calibrat-
ing displays. Spectrophotometers are used 
to calibrate and profile displays, and they are 
also useful for creating profiles for output 
devices such as printers.

For more information on measurement 
devices, visit the Macintosh Products Guide 
at www.apple.com/guide.

Apple displays
Apple displays offer a depth of 16.7 million 
colors and let you see consistent color from 
a 170° viewing angle. Independent studies 
have shown that Apple Cinema Displays 
are extremely accurate right out of the box, 
with little deviation from the factory profiles. 
Apple’s industry-leading LCD displays are 
flicker-free, with twice the brightness, twice 
the sharpness, and twice the contrast of 
typical CRT displays. Unlike other flat-panel 
displays, they’re designed with a pure digital 
interface to deliver distortion-free images 
and enable precision editing. For more 
information, see www.apple.com/displays.
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Communicating Consistent Color
Once your display is calibrated and profiled and all of your images have color profiles 
embedded, your Mac OS X applications such as Preview, Mail, Safari, and Adobe 
Photoshop are capable of accurate color soft proofing. In addition, the correct color 
space conversions for output are now easy to accomplish. 

When displays are calibrated and profiled correctly, you can share documents with 
colleagues using Mac OS X and be assured that they will see the same colors. For 
example, you can post images on your web page and those viewing them will see 
the correct colors in Safari. You can email files in Mail with accurate color. Applications 
that use Quartz are automatically color-managed using ColorSync for accurate color 
soft proofing.

Converting to a Preferred Color Space
Some color-aware applications will ask you to choose a preferred working space. A 
good working space for images provides consistency in defining neutral colors. When 
all three colors (red, green, and blue) have the same value, such as R100, G100, B100, 
and the resulting color is neutral, without any color cast or tint, the color space is con-
sidered linear. Common linear color spaces like Adobe RGB (1998) are ideal for editing 
and archiving images, while the smaller sRGB space provides a linear color space when 
dealing with multiple devices in a non-color-managed workflow. This is not always the 
case with the color profiles of RGB devices, especially those used for printing. For edit-
ing and archiving, it’s best to select a working space with a gamut that overreaches or 
matches the gamut of the capture (input) device.

Creating graphics for the web 
At times you may want to convert your 
images to another color space for optimal 
viewing on the web. For instance, suppose 
you have a number of files in Adobe 
RGB (1998), which is ideal for editing and 
archiving images, but you want to post 
them to a web page where sRGB is a more 
appropriate color space. If you convert your 
images to sRBG and attach the sRBG profile, 
colors will be interpreted correctly by color-
savvy applications like Safari, and the images 
will maintain a small gamut for adequate 
display on non-color-managed devices and 
applications.
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Color Workflow: Output

ColorSync in Mac OS X allows you to share your work with confidence. With an ICC-
based color-managed workflow, you’ll spend far less time and money achieving the 
color you desire. Mac OS X Tiger provides several capabilities to help ensure this. You 
can examine an accurate color preview onscreen prior to printing a hard copy of 
your files. You can share virtual color proofs with colleagues. Using the capabilities in 
the various formats of PDF, you can decide at what point in your workflow you want 
to apply color management to all your documents. And you’ll enjoy consistent color 
when printing your documents.

Sharing Virtual Color Proofs
Suppose you want to send an image electronically that would accurately represent 
the colors of the image if it were printed. Digital cameras are capable of capturing 
a large gamut of colors. Displays are capable of displaying a large gamut of colors. 
But printers may not be able to re-create the same gamut of colors. To compensate, 
a virtual color proof can be created where the resulting document is limited to repre-
sent the desired output device. 

Creating a virtual color proof with Preview
The Preview application in Mac OS X can apply color profiles and convert the colors 
in a document to fit within a specified color space. To convert a document’s colors 
to fit within another color space, choose the “Match to Profile” command in the Tools 
menu. Select the appropriate color model and color profile for the conversion and 
click OK. The soft proof of the image is updated to reflect the effect of this conversion. 
This functionality is different from the Assign Profile option. To match to another color 
profile, you are adjusting the color of every pixel in the image as it’s converted into a 
new color space. You might want to save the adjusted file as a copy in order to retain 
the original data. 

Creating a virtual color proof with Aperture
Aperture, Apple’s new post-production tool for photographers, can perform onscreen 
color proofing with ColorSync. Because ColorSync provides a registration system for 
your color profiles and devices, the profiles in your system are available in Aperture. 
To proof colors onscreen while working with your images, choose View > Onscreen 
Proofing, then select the appropriate profile to proof against with View > Proofing 
Profile. Once the image has been adjusted accordingly, you can export a version of 
the image with the profile of your choice.

To create a virtual color proof for a particular device using Export Presets, choose 
Aperture > Presets > Export Presets, then create a new preset by clicking the Add (+) 
button at bottom left of the dialog. On the right side of the dialog is the ColorSync 
Profile setting; use for selecting the output device to create the virtual color proof. 



18Technology Tour
Color Management with Mac OS X Tiger

Because Aperture is a nondestructive image processing application, you can create mul-
tiple color proofs for each of your devices. When a version of the image is exported, it is 
matched to the gamut of the selected ColorSync profile using the relative colorimetric 
rendering intent.

Creating an Export Preset in Aperture. The resulting exported images will be confined to the 
color space of the selected ColorSync profile.

Creating a virtual color proof with Adobe Photoshop
To produce a virtual color proof using Photoshop, choose File > Print with Preview. 
Make sure that Color Handling is set to Let Printer Determine Colors, to pass the 
embedded profile from the file to the printer driver. When the Print dialog appears, 
choose “Save as PDF” from the PDF pop-up menu. Another user can now accurately 
view the resulting PDF in Preview, Mail, or Safari—all of these applications display 
the correct color-managed soft proof, matching the preview you originally saw in 
Photoshop.

Generating a virtual color proof with Adobe Photoshop.
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Creating a virtual color proof with ColorSync Utility
You can also use ColorSync Utility for color space conversions. From the File menu, 
choose Open and select the image you wish to convert. The image will appear 
correctly soft-proofed based on the embedded profile. At the bottom of the file’s 
window, choose the appropriate printer profile from the Output menu. When con-
verting to an output color space, you can pick a rendering intent for the color space 
conversion using the Intent pop-up menu. Click Apply and the soft proof is updated 
to show how the image will appear after conversion. 

Experiment by selecting the rendering intent that produces your preferred color 
appearance based on the image and the profiles being used. The best rendering intent 
is often image-specific. Now choose Save As from the File menu to apply the conver-
sion and save the new file to your hard drive. The file is now ready to be output to 
your printer or sent electronically as a virtual color proof. 

Checking Color with Print Preview 
You have seen how virtual color proofing can be used in several applications to 
examine the color of your files. Using the Preview button in the Print dialog, you can 
also see color-accurate previews at print time from any printer driver. Once you click 
this button, your print job appears in the Preview application as an accurate soft proof 
using that printer’s color profile. If everything looks as you wish, simply click the Print 
button to send the color-managed file to the output device. You can update the vari-
ous options in the Print dialog and regenerate PDF soft proofs in Preview until you are 
satisfied with the results, and then send the data to the printer.

 

The Preview button in the standard Print dialog of Mac OS X.

PDF and PostScript Support
From any printer driver in Mac OS X, you can access PDF Services to prepare a PDF 
document for output with options such as encryption and compression. You can 
configure your own PDF Services and save them for use in other applications using 
the standard Print dialog in Mac OS X. You can also create PDF/X-3 documents or 
even fax the page to a colleague, all from one dialog. The benefit of PDF is that all 
color-managed elements are encoded into a single file format. You can also save a 
PDF document as a PostScript file if the output device requires PostScript.
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PDF/X-3 support
When Mac OS X saves a file in PDF/X-3 format, it creates a prepress, industry-specific 
PDF file that is supplemented with additional information required by the PDF/X 
specification. This additional information is used in PDF-based prepress workflows to 
enhance the ease and reliability of commercially printed output. PDF/X-3 files save you 
time and money because they are easily validated, preflighted, and output by a wide 
variety of prepress software.

 

Creating a PDF/X-3 file using Quartz Filters.

Faster printing on a PostScript printer
In the past, PostScript printers handled color space conversions. Now with Mac OS X 
Tiger, you can choose to have your Mac handle color conversions rather than using the 
PostScript printer for processing, which can dramatically accelerate color conversions. 

In your printer driver, choose ColorSync from the pop-up menu as shown in the figure 
below. If the driver can use this feature, you’ll see two options in the Color Conversion 
pop-up menu: Standard and In Printer. If the Standard option is selected, your Mac 
will process the data, taking advantage of the power of its processor. For example, 
ColorSync can use the power of a Power Mac G5 to greatly speed up the color space 
conversions, as compared with In Printer, which uses the printer hardware.

Setting In Printer option for PostScript in Mac OS X.
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Using Quartz Filters
PDF documents in Mac OS X Tiger can be further refined using Quartz Filters. These 
filters let you apply color management, color effects, and other processing options 
such as compression or creation of files in PDF/X-3 format. To access Quartz Filters, 
click Filters in the toolbar of ColorSync Utility. Here you see the Quartz Filters that ship 
with Mac OS X Tiger. You can duplicate and modify these filters or create your own 
using ColorSync Utility.

To create your own Quartz Filter, click the Add (+) button in the bottom left of the 
window and enter a name for the Quartz Filter. Press the Enter key and ColorSync 
Utility saves the name of your Quartz Filter. Click the triangle to the right of the 
name to see the Quartz Filter options. You can assign ICC profiles; convert to a new 
color space using profiles; apply color effects; change the bit depth, dimensions, 
and compression; or add comments to a PDF document. Your Quartz Filter can now 
be accessed from the Mac OS X Print dialog. Quartz Filters can also be accessed in 
Automator (see the “Color Workflow: Automation” section).

Creating a Quartz Filter with ColorSync Utility.
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Workflow Considerations for Output
As previously discussed, at least two profiles are needed for color management to 
work correctly and predictably: the source profile and the destination profile. When 
and how you choose to apply the color conversions to the output profile’s color space 
will affect how you approach your workflow. 

Consider the following two scenarios that involve a single-page layout consisting of 
a photo from one application, vector artwork from another, and a final layout that 
includes text.

If you choose to apply the necessary color conversions to each image and artwork file 
before combining into a page in a page-layout application—a process known as early 
binding—the resulting file contains all the elements: graphics, text, and images in an 
output-ready color space for your chosen output device. 

In this method, each element has previously been converted in another application 
and optimized for a particular output device before being inserted into the final lay-
out. If you need to print this file to another output device, you will need to go back 
to the original source files to convert the color space and once again place them in 
your layout.

An alternative workflow method is to apply the color conversion to the output color 
space on the fly at print time. With this method, images are left in their working space 
and ColorSync performs the final color space conversion at print time—a process 
known as late binding. Whether to choose early or late binding depends on a number 
of factors and your preferences. Either method can be used with Mac OS X Tiger. 



23Technology Tour
Color Management with Mac OS X Tiger

Color Workflow: Automation

Everyone who uses a computer knows how time-consuming and tedious it can be 
to perform the same series of tasks over and over again. Mac OS X Tiger includes 
many technologies for automating tasks and applications—such as processing hun-
dreds of images by resizing them, applying color profiles, or even changing the file 
format. Automation in the workflow can make you more productive while saving 
time and money. 

Image Events
Mac OS X Tiger includes Image Events, a scriptable image processing architecture 
that enables AppleScript, Automator, and even the command line in Terminal to 
perform basic image edits such as cropping, scaling, rotation, and color conversions, 
without requiring any other applications. Custom workflows can be created that 
interact with a variety of tools and applications in Mac OS X. 

Automating Color Management Tasks with AppleScript 
Mac OS X Tiger ships with a number of AppleScript applications that can automate 
ColorSync-related processes. AppleScript is an English-like scripting language that 
automates the actions of the computer and the applications that run on it. Because 
ColorSync is scriptable, you can use this powerful technology to automate embedding 
color profiles, converting images to other color spaces, extracting profiles from images, 
and controlling other ColorSync tasks.

An example of an AppleScript script in Mac OS X is Embed Chosen Profile. With this 
script, you will be asked to specify an image and then an ICC profile to embed in it. 
The real power of AppleScript comes into play when connecting other applications 
or scripts into complete workflows. For example, the Image Capture application can 
perform tasks that you specify. Scripts can be attached to folders to produce what are 
called Folder Actions, which are activated when files are moved into those folders. 

AppleScript also makes available a systemwide Script Menu to launch scripts. To turn 
on the Script Menu, open AppleScript Utility, located in the Applications folder, and 
check the option “Show Script Menu in menu bar.” 

AppleScript allows individuals and businesses to create customizable automation tools 
that enable them to be more productive by reducing repetitive tasks and eliminating 
human error.

AppleScript in Mac OS X
Mac OS X Tiger ships with many additional 
AppleScript scripts that can aid in handling 
color management tasks: 

• Build profile info web page 
• Change display profile 
• Embed chosen profile 
• Embed display profile 
• Embed specific profile 
• Extract profile 
• Match to chosen profiles 
• Match to CMYK 
• Match to specific profiles 
• Mimic PC monitor 
• PC to Mac gamma 
• Proof CMYK on display 
• Proof to chosen profiles 
• Proof to specific profiles 
• Remove profile from image 
• Rename profile 
• Set profile info 
• Show profile info
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Simplifying Automation Using Automator 
Mac OS X Tiger introduces Automator, a simple-to-use drag-and-drop application for 
creating custom workflows that automate repetitive manual tasks. Automator contains 
actions that direct ColorSync to convert files using ICC profiles. You can also make 
custom workflows that can speed up production using PDF files.

Automator and image processing
Image processing tasks like embedding color profiles can be performed easily with 
Automator. For example, to create a workflow that changes the color profile for 
a series of images, select Preview in the Automator Library and drag the “Apply 
ColorSync Profile to Images” action into the workflow area. You will be asked if you 
want to add a Copy Finder Items action so the original files are not permanently 
altered; if you want to apply actions on a copy of the original file, click Add. In the 
Copy Finder Items pane, choose any folder you wish or use the default (Desktop). In 
the “Apply ColorSync Profile to Images” action, select an ICC profile from the pop-up 
menu to use for the color conversion. 

This workflow can now be saved as an application. However, the real power comes 
into play if you save a group of actions as a plug-in. You can select different types of 
plug-ins depending on how you want to utilize them. Automator plug-ins include: 

Finder. Adds the Automator workflow to the contextual menu accessible in the Finder.

Folder Actions. Allow you to select a folder on your hard drive that will run the 
Automator workflow when items are added.

iCal Alarm. Runs the workflow at times and dates specified in iCal, the easy-to-use 
calendaring application in Mac OS X.

Image Capture. Runs the workflow using the Automated Tasks option in Image 
Capture.

Print Workflow. Integrates your Automator workflow into the PDF Services of the 
Print dialog in Mac OS X, giving you access to PDF-based workflows from most 
applications.

Script Menu. If you have enabled the AppleScript Script Menu, your workflow will also 
be accessible from the AppleScript menu in all applications.

Creating an Automator workflow for assigning color profiles to images.
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Automator and printing
Mac OS X Tiger comes with two Automator actions that can greatly speed up the 
printing of your files. With the Print Finder Items action, once a printer is set up, any 
items you select in the Finder will be sent to that output device. By creating differ-
ent workflows for each printer, you can quickly and correctly output your documents. 
Another action, Print Images, provides options to center images, auto-rotate images, 
and scale to fit images for printing to any printer. 

 

 

 

 
Integrating an Automator workflow into the Quartz printing system in Mac OS X.
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Summary 

By utilizing a systemwide and standards-based approach to color management, Mac 
OS X gives you the control, accuracy, and consistency that you need to communicate 
effectively with color. With ColorSync integrated at the core of Mac OS X, you can work 
confidently and efficiently by:

• Viewing accurate color that matches expectations

• Achieving consistent color over time, across media, and using multiple vendors

• Coordinating and collaborating among distributed team members while maintaining 
color consistency

• Reducing production time and review cycles

• Lowering overall costs through greater efficiencies, fewer paper proofs, and less rework

• Increasing client satisfaction through faster turnaround, lower costs, and higher-quality 
products

ColorSync and Mac OS X deliver on the promise of higher productivity through 
accurate representation and consistent reproduction of color. No waste. No 
surprises. No disappointments. 
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Resources

To learn more about the topics mentioned in this Technology Tour, please consult 
the following resources.

Websites 
• ColorSync: www.apple.com/colorsync 

• Mac OS X: www.apple.com/macosx 

• International Color Consortium (ICC): www.color.org 

• Macintosh Products Guide: www.apple.com/guide 

• Apple Displays: www.apple.com/displays 

• AppleScript: www.apple.com/applescript 

• Color Consistency and Adobe Creative Suite (PDF): www.adobe.com/products/
creativesuite/PDFs/cscolormgmt.pdf

• Developer Tech Note—ColorSync in Mac OS X: developer.apple.com/technotes/
tn/tn2035.html

Profiling Services 
• www.chromix.com 

• www.colormanagement.com 

• www.digitaldog.net 

Books 
• Adobe Photoshop CS2 for Photographers, by Martin Evening 

• Adobe Photoshop Master Class, by John Paul Caponigro 

• Color Management for Photographers, by Andrew Rodney 

• Color Management in Mac OS X: A Practical Approach, by Joshua Weisberg

• Mastering Digital Printing: The Photographer’s and Artist’s Guide to High-Quality Digital 
Output, by Harold Johnson 

• Photoshop Color Correction, by Michael Kieran 

• Real World Adobe Photoshop CS, by David Blatner and Bruce Fraser 

• Real World Color Management, by Bruce Fraser, Chris Murphy, and Fred Bunting 
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For More Information
For more information about Mac OS X, 
ColorSync, and other Mac OS X technologies, 
visit www.apple.com/macosx.
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